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Sooner or later, you'll be looking for a re-
placement for your PC. What requirements 
must the hardware satisfy? This article will 
assume you will be using the Windows 7 op-
erating system, although almost any PC that 
supports Win 7 will also support any Linux 
distribution. If you purchase your PC from a 
well-established vendor, it will arrive with 
Windows already installed and well checked-
out. However, most of us keep our PCs for 
several years, which means that their perfor-
mance should exceed what is needed today. 
Software vendors know that to sell new ver-
sions of their products, they must add new 
features, and these require more from the 
hardware. Moore's Law, which says that inte-
grated circuit performance doubles every 18 
months, has been true for 30 years and 
shows no signs of changing in the near fu-
ture. As a consequence, six years from now, 
PCs will be eight times as powerful as to-
day's models, and software designers know 
and depend on this. Buying a barely ade-
quate PC means that it may not adequately 
run any software on it that it wasn't delivered 
with. 
 
Let's begin by looking at what hardware Mi-
crosoft recommends as a minimum for Win 
7. 

· 1 gigahertz (GHz) or faster 32-bit 

(x86) or 64-bit processor  

· 1 gigabyte (GB) RAM (32-bit) or 2 GB 

RAM (64-bit)  

· 16 GB available hard disk space (32-

bit) or 20 GB (64-bit) 

·  DirectX 9 graphics device with 

WDDM 1.0 or higher driver 

 

We see that the first choice is between a 32-
bit and a 64-bit processor. At present, most 
home applications are available only in 32-bit 
form, and while these will run in a 64-bit envi-
ronment, doing so provides little advantage, 
except that 64-bit CPUs can handle more 
RAM. (See the RAM discussion below.) This 
will probably change, perhaps as early as the 
next release or so of Windows. You might be 
tempted to go for a 64-bit processor, thinking 
that you will be able to upgrade to Win 8 or 
9; however, don't forget Moore's law. When 
the time comes to upgrade, you will certainly 
find that your PC is hopelessly under-
powered. A 32-bit processor is the correct 
choice, unless you have special require-
ments. 

 

Processor clock speeds can now exceed 3 
GHz, but processor architecture also greatly 
affects its computing rate, with the result that 
clock speed is not as good an indication of 
computing power as in the past. Indeed, 
AMD has stopped using clock speed to char-
acterize its processors. Manufactures 
achieve higher performance by putting multi-
ple processors (called cores) on a single 
chip. Get at least a 2-core processor and 
preferably a 4-core one. You may not see 
much advantage initially, but Windows slows 
down as the number of updates increase, 
and you probably will add new applications, 

(Continued on page 10) 

Buying a New Windows PC 



2       

 

“Members Helping Members” 
(since 1983) 

Board of Directors 

2010-2011 
 
  Robin B. Seidenberg . . . . . . . . . . . . . . President 
    president@lcace.org     
   
  Linda Busch . . . . . . . . . . . . . . . . .Vice President 
    vicepresident@lcace.org 
 
  Bobby Jacobs. . . . . . . . . . . . . . . . . . . .Secretary 
    secretary@lcace.org 
 
  Winnie Frost . .  . . . . . . . . . . . . . . . . . . Treasurer 
    treasurer@lcace.org  
 
  Lester Larkin . . . . . . . . . . . . . . . . . . . . Programs 
    programs@lcace.org 
 
  Liz Barnett  . . . . . . . . . . . . . . . . . . . .Membership 
    membership@lcace.org 
  Dwight “J.J.” Johnson . .Membership Co-Chair 
 
  Linda Koudelka . . . . . . . . . . . .  Public Relations 
   pr@lcace.org   
 

Volunteers 
 Webmaster/Historian . . . . . . . . . . . Lester Larkin 
   webmaster@lcace.org 
 
 Newsletter Editor ……….....Michael J. Mc Enery 

   editor@lcace.org 
 

News Journal 
The LCACE News Journal is published eleven 
times annually. Members are encouraged to 
submit contributions which will be acknowledged 
in this newsletter. 
 

Send articles to editor@lcace.org 
Permission is granted to reproduce any or all 
parts of this newsletter in other User Group 
publications, provided that credit is given to 
LCACE and the individual author(s).  
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Lake County Area 
Computer Enthusiasts 

 
LCACE 
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Membership 
LCACE membership is open to all individuals and 
families interested in personal computing. Annual 
dues are $20.00 per individual/family. 
Applications for membership may be obtained at 
the monthly meeting, by request on the club 
hotline, and are now available on our web site at   
http://www.lcace.org. 

 

Meetings 
LCACE meetings are usually held on Saturdays 
at the Grayslake Area Public Library, 100 Library 
Lane, Grayslake, Illinois. The meeting room 
opens at noon and  the formal meeting begins at 
12:30 p.m.  All meetings are open to the public.  
Bring a friend! 

 

Newsletter Submissions 
Club members are welcome to submit classified 
ads, reviews, tips and other articles for 
publication, to our newsletter editor in Microsoft 
Word format (.doc). Publication deadline is the 
20th of the month for all ads and articles. 
Please do not use tabs or special formatting.  

 

Newsletter Advertising 
Ad rates per issue: Full page - $25, Half page - 
$15, Quarter page - $10, Business Card - $5. 
Discounts are available on advance purchase of 
multiple issues. Please send camera-ready copy 
and payment to the club address by the 15th of 
the month preceding publication. For more 
information on ad pricing, please call our Hotline. 
Ads are FREE to all paid members. 
 

 Notice 
LCACE WILL NOT CONDONE  or knowingly 
participate in copyright infringement of  any kind. 
The LCACE News Journal is published by and 
for LCACE members. Opinions expressed herein 
are those of the individual authors and do not 
necessarily reflect the opinion of LCACE, the 
membership, the board of directors, and/or our 
advertisers. 

mailto:president@lcace.org
mailto:vicepresident@lcace.org
mailto:secretary@lcace.org
mailto:treasurer@lcace.org
mailto:programs@lcace.org
mailto:membership@lcace.org
mailto:pr@lcace.org
mailto:webmaster@lcace.org
mailto:editor@lcace.org
mailto:editor@lcace.org
mailto:jj1450xl@yahoo.com
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Robin’s RAMblings 

 

 
Have you thought about how tech-
nology has changed our lives?  We 
recently traveled to Washington, 
D.C. for a genealogy conference.  At 
the airports and on the planes it 
seemed as though most people were 
using iPads, iPods, or laptops and 

the occasional netbook.  At the 2008 conference 
when attendees saw my new little netbook they 
asked what it was and where I got it.  A cousin 
couldn't stop using it. 
 
What a difference three years makes!  This year 
many conference attendees were using iPads.  
Tablets are supposed to be taking over the lap-
top market.  There is no question that netbook 
sales are way down. 
 
En route back to D.C. after visiting a friend in 
Richmond, Virginia, we needed to check our 
plane reservations so I turned on my laptop, 
plugged in my aircard, and got online.  The 3G 
connection out in the middle of nowhere was 
considerably slower than the 4G I got in down-
town D.C., but it worked--which is kind of amaz-
ing.  Five or ten years ago this would have been 
unthinkable. 
 
Another change was that nearly everyone had a 
smartphone.  People were checking their email, 
texting, taking pictures, browsing the web, and, 
yes, making the occasional phone call.  Their 
uses don't stop there.  We needed directions to 
the airport when leaving our hotel in D.C.  I just 
hit the navigation icon, touched "speak destina-
tion", and said "Reagan National Airport".  It 
quickly gave us directions and we were on our 
way.  This inexpensive phone has more compu-
ting power than some computers I've owned. 
 
Speaking of iPads... Would you like to win one?  
The second prize in this year's LCACE holiday 
raffle is an iPad2. 
 

This year's EXCITING prizes are: 
 
1st prize-HP 17.3" Notebook with AMD Phe-
nom II Processor, 4GB of RAM, 500GB hard 
drive, 8X DVD±R/RW with Double Layer Sup-
port, integrated digital media reader, HDMI out-
put for connection to an HDTV and Windows 7. 
 
2nd prize-Apple iPad 2 Wi-Fi-16GB-White 
Tablet with 1GHz dual-core Apple A5 chip, 
front and back cameras, built-In Wi-Fi  
(802.11a/b/g/n) and Bluetooth, up to 10 hours 
battery life. 
 
3rd prize-HP Laserjet P2035 printer 
 
4th prize-One year LCACE membership  
 
Tickets are $1 each; 6 for $5, and 25 for $20.  
The more tickets you buy, the better your 
chances of winning one of these fabulous priz-
es.  Winners do not need to be present so plan 
to sell tickets to out of town family and friends.   
 
Raffle tickets will be available for sale at our 
September meeting.  In addition to buying tick-
ets for yourself, please plan to pick up tickets to 
sell.  The person who sells the winning first 
prize ticket and also the person who sells the 
most tickets will receive prizes at the holiday 
party. 
 
 
We have great programs scheduled: 
 
September 10, 2011-Acronis True Image Home 
(backup and imaging software) webinar by 
Gene Barlow 
 
October 15, 2011-Using Skype phone service 
by Charles Mages 
 
November 12, 2011-Digital macro photography 
by Wendy Warden 
 
December 10, 2011-Holiday party at State 
Bank of the Lakes 
 
January 7, 2012- 
 
February 11, 2012- 
 
If you haven’t already done so, it’s time to pay 
your dues. 
 
Happy computing! 
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The August meeting was ably conducted 
by Vice President Linda Busch, in the 
absence of Robin Seidenberg.  Officers 
in attendance, besides Linda Busch, 

were Bobby Jacobs, Winnie Frost, Lester Larkin, 
Liz Barnett,  Linda Koudelka. 
 
Those officers who had anything to report, did so 
as called upon by presiding officer Linda B.  The 
annual Holiday Party was discussed during the 
old business portion of the meeting, in particular 
the advantage to both buyers and sellers of raffle 
tickets.  Fred Barnett operated the wall projected 
agenda during the meeting. 
 
Two door prizes were given out: Joe Kusiak won 
a 4 GB SanDisk flash memory, and Eric Re-
hberger won a cucumber (probably one of those 
new vineless type that requires batteries).  Marge 
Wallin won $11.50 in the 50/50 drawing. 
 
After the business part of the meeting, we had 
the Show & Tell - Ask the Gurus period.  Lester 
Larkin showed us some of the features of two 
high school reunion websites he works with.  This 
was followed by Ask the Gurus.  Marge Wallin 
inquired about how she might copy some music 
onto a CD.  Many members gave her many use-
ful suggestions.  There was some discussion 
about the Norton backup utility. 

L.C.A.C.E. HISTORIAN 
Report, 8/13/11  
By Les Larkin, Club Historian 

Email etiquette 

 
If you are sending an email to more than one 
person, send it as a blind copy.  On more than 

one occasion I have been ex-
posed to viruses because some-
one included my email address 
in a bulk mailing.  PLEASE send 
as a BCC (=blind carbon copy).   
 
Please do not forward emails.  If 

you wish to send the information to someone 
else, copy and paste the contents into a new 
email.  It is extremely rude to forward an email, 
particularly one that includes a long list of pre-
vious recipients.   
 
Before you send out any information, PLEASE 
verify it at www.snopes.com.  It doesn't matter 
how many people send it to you or how 
"reliable" the source, verify it!  I receive many 
emails every month purporting to warn about 
various dangers.  Most are false.  It doesn't 
matter if the person says they have checked it 
with snopes.com, do it yourself! 
 
If an email says to send to "everyone in your 
address book", it is most likely far more dan-
gerous than the what it purports to warn 
against.  Emails that say "sign this petition", 
"you'll get bad (or good) luck", "you'll see 
something funny on your screen after send-
ing", etc., often are attached to email tracker 
programs.  Please don't help the spammers! 

Editorial 
By Angus MacTavish 

Lois Brondy 
Julio Rivera 

SUPERCOMPUTER:SUPERCOMPUTER:  
 

“What it sounded 

like before you 

bought it.” 



 5 

 

When working with longer tables in a docu-
ment, you may wonder if there were a way to 
repeat rows at the bottom of a table that 
spans multiple pages, the same way you can 
repeat rows at the top of a multi-page table. 
The short answer is that Word doesn't provide 
such a capability. If you are willing to experi-
ment a bit, you can try to come up with a 
workaround that may do the trick for you. 

What you want to do is create a document 
section that contains just your table, and then 
use the page footers to contain the rows you 
want repeated from the table. Follow these 
general steps: 

1. Just before the start of your table, 
insert a continuous section break. 

2. Do the same thing just after the end 
of your table. 

3. Select the rows you want repeated at 
the bottom of the table and copy 
them to the Clipboard. 

4. Choose View | Header and Footer to 
display the headers and footers of 
the document. (If you are using Word 
2007 or Word 2010 display the Insert 
tab of the ribbon, click Footer in the 
Header & Footer group, and then 
click Edit Footer.) 

5. Switch to the footer. (You don’t need 
to do this in Word 2007 and Word 
2010, since you are already editing 
the footer after step 4.) 

6. Make sure that the Link to Previous 
option is turned off for the footer. 

7. Select anything that already exists in 
the footer. 

8. Press CTRL+V to paste the copied 
rows into the footer. 

9. Use the controls on the Header and 
Footer toolbar or, in Word 2007 and 
Word 2010, the Design tab of the rib-
bon to advance to the next section. 
(You should be looking at the footer 
for the section following the section in 
which the table resides.) 

10. Turn off the Link to Previous option 
for this footer. 

11. Delete the table row from this sec-
tion's footer. 

12. Close the Header and Footer toolbar 
(click Close) or, in Word 2007 and 
Word 2010, click Close Header and 
Footer in the Close group. 

You are now ready to place the final touches 
on your workaround. Position the insertion 
point somewhere in your table, then use the 
various tabs in the Page Setup dialog box to 
adjust the relationship between your table 
and the footer. You'll need to play with the 
settings on both the Margins and Layout tabs 
to position the rows in the page footer, and 
you'll want to make sure that the Apply To 
drop-down list applies the changes to only 
the current section (the one with the table in 
it). 

Copyright © 2011 by Sharon Parq Associ-
ates, Inc. Reprinted by permission. Thou-
sands of free Microsoft Word tips can be 
found online at http://word.tips.net. 
 

Editorial 

Repeating Rows for a     

Table Footer 

http://www.pegasusphotos.zenfolio.com/
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Running a High School 

Reunion Website 

By Les Larkin 

 
Thinking about your high 
school reunion?  Something 
that could greatly enhance 
the experience of you and 
your classmates is your 
class having its own web-
site.  This aids in two way 
communication between 

your organizing committee and alumni, as 
well as communication between alum-
ni.  There are several high school reunion 
websites, each having its own appeal.  But 
since my experience is with 
the ClassReport.org website, that's what I'll 
be writing about. 
 
What does a class website provide?  It's a 
place where each alumnus/alumna has his/
her own profile.  In each profile there is a 
place for a yearbook photo, a current photo, 
a YouTube video, email address, link to one 
personal and one business website, birth 
month/day, spouse/partner name, children's 
names and birth years, employer, Facebook 
link, and biography.  Each day, part of the 
Profile of the Day is shown on the main page 
of your class's website.  Anyone who has 
posted his biography in his profile will have 
his biography featured for that day, along 
with any yearbook and/or current photo that 
was uploaded to the website.  Also, the per-
sonal or business website of anyone who 
has posted a link to it is displayed along with 
his profile photo(s). 
 
The main page of your Class Website con-
tains links to many of the features of the 
website, the most useful being the Class Di-
rectory.  That's where you can find the pro-
files of people you knew in high 
school.  Since one of the more important us-
es of the website is to inform alumni of an 
upcoming reunion, all that pertinent infor-
mation is posted near the top of the main 
page.  Other features that the Class Admin-
istrator can put on the main page are slide 
shows, and music. 
 
As much fun as it is to have a profile on your 

class's website, it's even more fun to be a 
Class, or Assistant Administrator!  I am an 
Assistant Administrator on the Arlington High 
School Class of 1960, and the Class Admin-
istrator (as Maxwell Power) (long story) on 
the Arlington High School Class of 1961 
website!  So if you ever get a chance to take 
on this rewarding project, GRAB IT! 
 
For those of you who are reading a paper 
copy of this article, here are the URLs for the 
above links: 
http://classreport.org/ 
http://www.classreport.org/usa/il/
arlington_heights/ahs/1960/ 
http://www.classreport.org/usa/il/
arlington_heights/ahs/1961/ 

Excel Tips 

Understanding Manual 

Calculation 
When you change a value in any cell of a 
worksheet, Excel automatically recalculates 
all the other formulas within the worksheet. 
This means that Excel is always up to date, 
based on any changes you may have per-
formed. 

If you have an absolutely huge worksheet or 
a terribly slow computer (or both), then doing 
a calculation after every change can get very 
tedious. In these situations, you can actually 
spend more time waiting on Excel to finish 
calculating than you do on entering infor-
mation. 

The answer to this problem is to configure 
Excel so that all calculations are done manu-
ally. This is easy to do by following these 
steps: 

1. Display the Excel Options dialog 
box. (In Excel 2007 click the Office 
button and then click Excel Options. 
In Excel 2010 display the File tab of 
the ribbon and then click Options.) 

(Continued on page 7) 
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2. Click the Formulas area at the left of the dialog box. 

 

The Formulas area of the Excel Options dialog box. 

3. In the Calculation Options section of the dialog box, make sure the Manual radio button is 
selected. 

4. Click on OK. 

Now, Excel does not calculate your worksheet automatically. Instead, you must press F9 whenever 
you want to update the results displayed within your worksheet. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Mi-
crosoft Excel tips can be found online at http://excel.tips.net. 
 

(Continued from page 6) 
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Repeating Rows for a Ta-

ble Footer 
When working with longer tables in a docu-
ment, you may wonder if there were a way to 
repeat rows at the bottom of a table that 
spans multiple pages, the same way you can 
repeat rows at the top of a multi-page table. 
The short answer is that Word doesn't pro-
vide such a capability. If you are willing to 
experiment a bit, you can try to come up with 
a workaround that may do the trick for you. 

What you want to do is create a document 
section that contains just your table, and 
then use the page footers to contain the rows 
you want repeated from the table. Follow 
these general steps: 

1. Just before the start of your table, 
insert a continuous section break. 

2. Do the same thing just after the end 
of your table. 

3. Select the rows you want repeated 
at the bottom of the table and copy 
them to the Clipboard. 

4. Choose View | Header and Footer 
to display the headers and footers 
of the document. (If you are using 
Word 2007 or Word 2010 display 
the Insert tab of the ribbon, click 
Footer in the Header & Footer 
group, and then click Edit Footer.) 

5. Switch to the footer. (You don’t 
need to do this in Word 2007 and 

Word 2010, since you are already 
editing the footer after step 4.) 

6. Make sure that the Link to Previous 
option is turned off for the footer. 

7. Select anything that already exists in 
the footer. 

8. Press CTRL+V to paste the copied 
rows into the footer. 

9. Use the controls on the Header and 
Footer toolbar or, in Word 2007 and 
Word 2010, the Design tab of the 
ribbon to advance to the next sec-
tion. (You should be looking at the 
footer for the section following the 
section in which the table resides.) 

10. Turn off the Link to Previous option 
for this footer. 

11. Delete the table row from this sec-
tion's footer. 

12. Close the Header and Footer toolbar 
(click Close) or, in Word 2007 and 
Word 2010, click Close Header and 
Footer in the Close group. 

You are now ready to place the final touches 
on your workaround. Position the insertion 
point somewhere in your table, then use the 
various tabs in the Page Setup dialog box to 
adjust the relationship between your table 
and the footer. You'll need to play with the 
settings on both the Margins and Layout tabs 
to position the rows in the page footer, and 
you'll want to make sure that the Apply To 
drop-down list applies the changes to only 
the current section (the one with the table in 
it). 

Copyright © 2011 by Sharon Parq Associates, 
Inc. Reprinted by permission. Thousands of free 
Microsoft Word tips can be found online at http://
word.tips.net. 

Word Tips 

“Some things man 

was never meant to 

know.  For everything 

else there is Google.” 
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which become more resource-hungry with 
each release. Note the important difference 
between multi-core processors and multiple 
processors. The former are single packages 
with more than one computing component; 
the latter are multiple packages, each with 
its own stacks, cache memory, and input/
output. Only the Professional, Enterprise, 
and Ultimate versions of WIN 7 can make 
use of more than one processor, although 
all 32-bit versions of WIN 7 can use up to 32 
cores.  

 

Finally, consider getting a CPU with a Intel-
VT or AMD-V supported and enabled. With-
out this, you can't run Windows Virtual PC, 
https://www.microsoft.com/windows/virtual-
pc/default.aspx.  

 

RAM is cheap, which means you should get 
as much as you can use. However, a 32-bit 
processor, can access a maximum 4 giga-
bytes of memory, and memory includes not 
only RAM, but also video RAM. If you have 
a high-end graphics controller with 1 GB of 
video RAM, your processor can use only up 
to 3 GB or RAM. Remember though, that 
many people use just a video controller on 
their motherboard, and such units use regu-
lar RAM for video storage. Once your sys-
tem fills RAM with data, it begins to use 
swap space on your disk, and this drastical-
ly slows performance. I recommend you in-
stall as much RAM as your processor can 
address, 4 GB if you use an integrated vid-
eo controller, perhaps somewhat less if you 
have a separate one. You can see a prob-
lem developing here; because the recom-
mended RAM is at the limit of what the pro-
cessor can see. To use more RAM, you 
have to use a 64-bit CPU and operating 
system, which is why I think that we will 
soon see a move to this configuration. 

 

I recommend at least a 2000-GB (2-TB) 
hard disk. You do not want to run out of disk 
space and have to port all your software 
and data to a new one. Faced with  this, 
most home PC users would decide to pur-
chase a new PC. A competent PC shop can 
do this for you, and while the cost is reason-
able, it will certainly exceed any savings you 

(Continued from page 1) realized by skimping on the original disk 
size. 

 

Most home PC users will find that the mini-
mum video controller specified by Microsoft 
is adequate, but if you play action games or 
have specialized needs, such as photo edit-
ing or computer-aided design (CAD) you 
probably need a separate high performance 
video card, perhaps one compatible with 
DirectX 10 or 11. Graphics cards have faster 
processors than those mounted on mother-
boards and their video RAM is separate 
from that on the motherboard. You will have 
to do some research into the recommenda-
tions of your software vendors, not just for 
what you now use, but also for what you 
may soon install. However, replacing your 
video controller is much easier than chang-
ing disks, so you can upgrade later if need-
ed. Pay attention to the connector for the 
display; although VGA is still common, many 
high-performance controllers use Digital Vis-
ual Interface (DVI), High-Definition Multime-
dia Interface (HDMI), or Display Port. 

 

Besides the basics above, you also need 
some peripherals, and the most important of 
these is the display. You will probably follow 
the recommendations of the PC vendor, but 
consider getting a larger one than standard. 
As we age, our vision dims and blurs, and 
more visual real-estate allows us to magnify 
images, which makes computer time more 
comfortable. Be a little careful here, and be 
sure the display interface is compatible with 
your video controller. Of course, you need a 
read-write DVD drive, and you may want to 
get one that handles Blue-Ray. If you have a 
pile of diskettes, you may also want a floppy 
drive, but the need for these is fading fast. 
Get as many USB ports as you can (version 
2.0 or later), and at least two should be on 
the front panel. If you run out of ports, you 
can add USB hubs, but the result is a tangle 
of cables, power cords, and power supplies. 
(This will happen anyway, but try to avoid 
making it worse.) Keyboards and mice are 
cheap commodities and are easily upgrad-
ed. Current PCs use USB ports to communi-
cate with keyboards and mice, so you may 
not be able to transfer these from your old 
system. 
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Take a good 

look, you just 

might see  

yourself. 

http://lcace.org/PhotoAlbums.htm 

Have your Web Site Advertised here, 
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www.pegasusphotos.zenfolio.com 
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Kline, Cherie catmom1001@aol.com 

Kostelnik, Steve steve_kostelnik@usa.net 

Koudelka, Linda & Robert koudelka3@comcast.net 

Kusiak, Joseph juj014@att.net 

Lagoni, Doreen bearmagic1999@aol.com 

Larkin, Lester LesLarkin@aim.com 

Lewis, Carolyn lewis.linwood@att.net 

Martin, Donald dmartin339@comcast.net 

Mata-Guzman, Marta marta5131959@yahoo.com 

McEnery, Mike mmcenery@sbcglobal.net 

Nickels, Cheryl cnickels1110@yahoo.com 

Nocerino, Phil windpiper2@yahoo.com 

Ortseifen, Patricia patricia@ortseifen.com 

Rehberger, Eric graduates63@gmail.com 

Rivera, Julio jlrivera@db3mail.com 

Rudnit, Harriet hrudnit@yahoo.com 

Salsburg, Leslie leslie164@juno.com 

Savage, Danjean & Ken kennethisavage@hotmail.com 

Seidenberg, Lew drlew1@aol.com 

Seidenberg, Robin anguslechat@aol.com 

Smatlak, Ellen emsmis@hotmail.com 

Straw, Gerald gkstraw@comcast.net 

Sturek, Jorja jksturek@sbcglobal.net 

Sutherland, Dorothy deedee1938@yahoo.com 

Urh, John johnurh@sbcglobal.net 

Wagner, Richard & Belinda SenoritaBW@AOL.com 

Wells, Alden alden_racing74@yahoo.com 

  

  

http://lcace.org/PhotoAlbums.htm
mailto:editor@lcace.org?subject=Web%20site%20ad
http://www.pegasusphotos.zenfolio.com
http://www.RobinSeidenberg.com
http://lcace.org
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September 

10 

Saturday 

Next Meeting 

Meeting Agenda: http://lcace.org/agendas.htm 

Meeting Agenda 

Acronis True Image Home 

(backup and imaging software) 

presented by 

Gene Barlow. 

http://lcace.org/agendas.htm

